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Version:  36 

Revised: 9 May 2019 

.....IMPORTANT….. 

Use the supplied power adaptor only. 

The use of any other power source may result in data corruption 

and permanent damage to the unit and voids the warranty. 

The Selfie Wizard has a built-in UPS to perform a safe shutdown on 

loss of power. 

It must be allowed to fully shutdown, approximately 1 minute until 

ALL lights go off before reapplying power to restart. 

 

 

…….Wizard Version Only……. 

When using a Display Device – turn ON the display device BEFORE 

applying power to the Selfie Wizard to enable HDMI output. 

 

Admin Password: 

The default Admin password is all lowercase:  swiz 

 

Have you joined the Selfie Wizard Owners Group..? 

For the fastest response to support enquiries and all the latest tips, 

tricks and idea sharing: 

facebook.com/groups/SelfieWizard/ 
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Ninja Version 

 

 Quick Start 

 

 Shutdown 

 Rebooting 

 Admin 

o Display Settings 

 WiFi SSID 

 Password 

 WiFi Channel  

o Printer Setup  

 System Update 

 How to..? 

o AirPrint 

o Network to a Computer 
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Wizard Version 

 

 Quick Start 

 

 Start Up 

 Shut Down 

 Rebooting 

 Admin 

o Display Settings 

 WiFi SSID 

 Browser URL 

 WiFi Channel 

 Screen Rotation 

 Display Settings 

 Display or Hold Images 

 Print Settings 

 Photo Wall Settings 

 Display Photos from 

 Sort Order 

o Photos on Show 

o Banned 

o On Hold 

o Advert Manager 

o USB 

o Printer Setup 

o System Update 

o Quick Reset 

o Help 

 

 Guest Photo Upload 

 

 How to..? 

o Network to a Computer 
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o Pre-Load image sets 

o Custom Overlays 

o Wireless Print Server  

o Wi-Fi Hotspot 

o Display Photo Booth Images 

o FTP Uploads 

 

 Problems..? 

o Screen Stutter 

o WiFi Connections 

o Guest Phone Connections 
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Ninja Version 
 

Quick Start 

Insert Power Adapter and turn on 

Plug in Printer USB (Printer will require initial setup) 

 

Connect your Phone to the SelfieWizard Wi-Fi Network 

 

The default WiFi password is: 12345678 

 

Open a web browser on your Phone 

To access the admin menu enter:  admin/ 

 

Some devices such as Windows PC’s may require the full access address of: 

10.10.10.10/admin/ 

 

To enable printing the RED RJ45 Data Plug must be inserted and remain attached 

to the Selfie Wizard 

 

 

Back to Top 

Shut down 

 

Simply turn off/remove power. 

The built in UPS system will perform a safe shut down after approximately 30 

seconds of removing power from the unit. 

Back to Top 

Rebooting 

Simply turn off/remove power. 

The built in UPS system will perform a safe shut down after approximately 30 

seconds of removing power from the unit. 
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The Selfie Wizard MUST be allowed to shutdown completely – All lights off 

BEFORE reapplying power. 

Back to Top 

Admin 

Main Settings 

 WiFi SSID  –  Default =  SelfieWizard 

This can be changed to something more appropriate. 

No spaces or special characters allowed. 

 

Click Apply and the Selfie Wizard will reboot after 5 seconds 

Reconnect your access device to the new Wi-Fi SSID. 

 

 Password – Default = 12345678 

This can be changed to something more appropriate. 

No spaces allowed. 

 

Click Apply and the Selfie Wizard will reboot after 5 seconds 

Reconnect your access device to the Wi-Fi network using the new password. 

 

WiFi Channel 

If you are experiencing poor range or interference for other Wi-Fi devices in the 

vicinity change the WIFI channel. 

Preferred Channels are 1, 6 and 11 

 

Click Apply and the Selfie Wizard will reboot after 5 seconds 

Reconnect your access device to the Wi-Fi network. 

 

Back to Top 

 

Printer Setup 

The Selfie Wizard uses the Linux CUPS printing system and is pre-loaded with 

drivers for all compatible Printers. 

To install and setup your Printer please follow these instructions carefully 
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 With the Selfie Wizard switched on, plug in the Printer USB 

 Turn Printer on 

 From the Admin Menu select ‘Printer Setup’ 

 On the CUPS Home Page select ‘Printers’ 

o Select ‘Add Printer’ 

  
Local Printers: should display the currently connected printer 

‘Check’ against this printer then click ‘Continue’ 

 

o TIP:  Give your Printer a friendly name - All other settings can be left 

as is then ‘Continue’ 

  
 

o From the Model list select you model of Printer – then ‘Add Printer’ 
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o Adjust Media Size if required – then ‘Set Default Options’ 

      
The printer is now added to the system 

 

o From the ‘Administration’ drop down select ‘Set As Server Default’ 

   
  

o From the ‘Maintenance’ drop down select ‘Print Test Page’

  
 

o The Printer should now print a Test Page and will be correctly set up 

for Automatic Printing 

Back to Top 

 

System Update 

 Connect the SelfieWizard to your Home or Office router using the YELLOW 

data cable supplied. 

 From a mobile phone, connect to the SelfieWizard WiFi 
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 Open a web browser and enter: admin/ 

Some devices may require the full url of: 10.10.10.10/admin/ 

 In the menu navigate to ‘System Update’ 

 This page will show your 

o Selfie Wizard ID 

o Current Software Version 

o Hardware Version 

o If there is an update available the ‘Run Update’ button will be visible 

 

Back to Top 

 

How To..? 

AirPrint from iPad 

Connect the iPad to the SelfieWizard WiFi  

Printers installed and connected to the Selfie Wizard will be available to the iPad 

print setup dialog 

Back to Top 

 

Connect to a Computer Network 

Shared Folders are not available on the APS Version 

 

Back to Top 
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Wizard Version 
 

Quick Start 

Plug the unit into a suitable TV or Display Device using the HDMI cable 

 

Switch on the TV  BEFORE  the Selfie Wizard 

The screen resolution is auto-detected by the Selfie Wizard at Startup – the TV 

must be on to enable this to happen 

 

Insert Power Adapter and turn on 

Insert blank USB Memory Stick (optional) 

Plug in Printer USB (Printer will require initial setup) 

 

Connect your Phone to the SelfieWizard Wi-Fi Network 

Open a web browser on your Phone 

To upload an Image enter:  selfie/  and follow on-screen instructions 

To access the admin menu enter:  admin/ 

 

Some areas and functions of the Selfie Wizard are protected  

Username: swiz 

Password:  swiz 

 

 

Back to Top 

 

Start Up 

Use HDMI cable to connect to TV or other Display Device and switch on Display 

device so that Screen Resolution is auto-detected when the Selfie Wizard powers 

up. 

Switch on power to the Selfie Wizard.  

For automatic saving of images, insert a USB memory stick (recommended 2gb+)  
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Insert Printer cable for instant Printing 

To enable printing the RED RJ45 Data Plug must be inserted and remain attached 

to the Selfie Wizard 

Back to Top 

 

Shut down 

 

Simply turn off/remove power. 

The built in UPS system will perform a safe shut down after approximately 30 

seconds of removing power from the unit. 

The TV or other display device will remain active during this procedure. 

Back to Top 

Rebooting 

Simply turn off/remove power. 

The built in UPS system will perform a safe shut down after approximately 30 

seconds of removing power from the unit. 

The Selfie Wizard MUST be allowed to shutdown completely – All lights off 

BEFORE reapplying power. 

Back to Top 

 

Admin 

Connect phone or other WiFi enabled device to the built in WiFi network. 

The default SSID is:  SelfieWizard 

Using the device web browser, Safari, Chrome, FireFox etc.  

Navigate to:  admin/ 

Various admin options are available from the page Menu. 

Windows Computers and Alternative method for Mobile Phones: 

Using the web browser, Safari, Chrome etc.   
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selfiewizard/admin/ 

10.10.10.10/admin/ 

  

Display Settings 

 WiFi SSID  – The SSID as it will be displayed to guests on their mobile devices. 

Default:  SelfieWizard 

This can be changed to something more appropriate to the event or your 

business name 

No spaces or special characters allowed. 

 

 Browser URL – The URL that guests need to enter into their browser to access 

the upload page. 

Default:   selfie/ 

This can be changed to anything you wish - No spaces or special characters 

allowed.  

TIP: Guests will need to type this in therefore its recommend this is set to 

something short, easy to remember and spell. 

 

 WiFi Channel – Available Channels are 1 – 11 

Allows changing Wi-Fi channels in the event of poor Wi-Fi range or difficulty 

connecting to the Selfie Wizard due to interference from other equipment 

being used at venues. 

Typically equipment such as WDMX controlled lighting, microphones etc. 

After changing channels and applying settings the Selfie Wizard will 

automatically reboot. Any connected devices will need to re-connect to the 

Selfie Wizard. 

 

 Screen Rotation – Set the screen rotation to match your Display Device 

 

 Show photos immediately 

 If checked, uploaded images will displayed in the slideshow immediately 

 If un-checked, uploaded images will be placed ‘On-Hold’ pending review 

 

 Print Settings 

o Enable or Disable Automatic Printing 

o High or Low Quality Printing 
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o Enable or Disable the use of a Print Overlay 

o Enter the number of copies to automatically print 

 

 Photo Wall Settings 

o Columns to Display 1-10 

o Speed 0 -10  (0 = Static) 

o Ad Frequency 0-100 

How often to display an advert in the Slideshow 

Set to 0 to disable 

 

 Display Photos from 

 The check boxes will allow the selection of which photo set(s) to display in 

the SlideShow. 

 Multiple sets can be selected. 

 See here for instructions on pre-loading images into Set A – D   

 

 Sort Order 

 Newest first will display images sorted by the upload time stamps. 

 Random will display images in a different random order on each run 

through.   

 

 

Apply Settings to save. 

If the SSID, Browser URL or Wi-Fi Channel have been changed the Selfie Wizard 

will automatically reboot after 10 seconds. 

A change to the SSID or Wi-Fi channel will require all connected devices to 

reconnect. 

Back to Top 

 

Photos On Show 

This page will display the images that are currently included in the Slideshow. 

The page will auto-refresh every 30 seconds. 

To ban an image simply click on the ‘Ban’ button. The image will be moved to the 

‘Banned’ folder and will be removed from the Slideshow on its next refresh. 

Back to Top 
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Banned 

This page will display the images that are currently Banned. 

To un-ban an image simply click on the ‘Show’ button. The image will be moved 

to the ‘On Show’ folder and will be included in the Slideshow on its next refresh. 

Back to Top 

 

On Hold 

If enabled in the Display Settings, uploaded images will be placed ‘On Hold’ 

pending a manual review. 

This page will display the images that are currently On Hold and will auto-refresh 

every 30 seconds. 

To Show or Ban an image simply click on the relevant button below the image. 

The image will be moved to the selected folder. Images moved to the ‘Show’ 

folder will be included in the Slideshow on its next refresh. 

Back to Top 

 

Advert Manager 

Advert/Splash Images in the Advert Bank are displayed in the left column. 

Advert/Splash Images available in the current SlideShow are displayed in the right 

column. 

Use the ‘Move to Show’ and ‘Move to Bank’ buttons to shuffle adverts back and 

forth. 

The ‘Delete’ button will permanently delete the advert from the Selfie Wizard. 

‘Upload New Advert’ button is at the bottom of the LEFT Advert Bank Column. 

Any .jpg or .png file can be uploaded for use as an advert image. Images are 

automatically resized to the correct resolution at the time of uploading. 

 

Back to Top 
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USB 

If a USB memory stick is inserted into the Selfie Wizard, uploaded images will be 

automatically saved to the memory stick. 

To transfer images at the end of an event or to create additional memory sticks, 

insert and follow the on-screen instructions. 

The unit allows hot plugging however take care to ensure write procedure have 

completed to avoid data corruption. 

Back to Top 

 

Printer Setup 

The Selfie Wizard uses the Linux CUPS printing system and is pre-loaded with 

drivers for all compatible Printers. 

To install and setup your Printer please follow these instructions carefully 

 With the Selfie Wizard switched on, plug in the Printer USB 

 Turn Printer on 

 From the Admin Menu select ‘Printer Setup’ 

 On the CUPS Home Page select ‘Printers’ 

o Select ‘Add Printer’ 

  
Local Printers: should display the currently connected printer 

‘Check’ against this printer then click ‘Continue’ 

 

o TIP:  Give your Printer a friendly name - All other settings can be left 

as is then ‘Continue’ 



Page | 17 
 

  
 

o From the Model list select you model of Printer – then ‘Add Printer’ 

  
 

o Adjust Media Size if required – then ‘Set Default Options’ 

      
The printer is now added to the system 

 

o From the ‘Administration’ drop down select ‘Set As Server Default’ 
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o From the ‘Maintenance’ drop down select ‘Print Test Page’

  
 

o The Printer should now print a Test Page and will be correctly set up 

for Automatic Printing 

Back to Top 

 

System Update 

 Connect the SelfieWizard to your Home or Office router using the YELLOW 

data cable supplied. 

 From a mobile phone, connect to the SelfieWizard WiFi 

 Open a web browser and enter: admin/ 

Some devices may require the full url of: 10.10.10.10/admin/ 

 In the menu navigate to ‘System Update’ 

 This page will show your 

o Selfie Wizard ID 

o Current Software Version 

o Hardware Version 

o If there is an update available the ‘Run Update’ button will be visible 

 

Back to Top 

 

Quick Reset 

This will perform a quick reset of the unit and delete all Guest uploaded images. 

CAUTION:  Images are PERMANENTLY Deleted and cannot be undone 

Back to Top 
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Help 

Link to this Help File 

Back to Top 

 

 

 

 

Guest Photo Upload 

1. Connect phone (or computer) to the built in WiFi network SSID:   

SelfieWizard 

Some versions of iOS and Android may complain about lack of internet 

connection as it is purely a local WiFi network with no external data 

connection, simply ignore this. 

 

2. Mobile Phones and Apple Devices: 

Using your web browser, Safari, Chrome etc.  Navigate to:    selfie/ 

The trailing slash / on the URL is important. It tells the browser that it is a local 

connection and not to try to do an internet search for the entered URL. 

 

Windows Computers and Alternative method for Mobile Phones: 

Using the web browser, Safari, Chrome etc.  Navigate to:    selfie.com 

 

3. Follow the onscreen instruction to upload images from your phone. 

 

 

 

 

Back to Top 

 

How To..? 
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Connect to a Computer Network 

There are 3 methods to network to the Selfie Wizard from another computer: 

 Wi-Fi – Connect your computer Wi-Fi to the Selfie Wizard Wi-Fi 

 Peer to Peer – Use the to connect the Selfie Wizard Yellow Data Cable 

directly to your computer 

 Router – Use the to connect the Selfie Wizard to your Yellow Data Cable 

home Wi-Fi router 

Windows Computers 

            
Network Discovery needs to be enabled on your Windows machine and the Selfie 

Wizard will show as a networked device. 

 

Protected areas will require the following login 

Username:  swiz 

Password:  swiz 

 

 

Windows 10 in particular can be fickle at finding the Selfie Wizard on the 

network. A more reliable method is Network Drive Mapping, described below: 
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1. Right-Click on ‘Computer’ and select ‘Map Network Drive’

 
 

2. Enter the following for the Folder setting: 

\\SELFIEWIZARD\Shared-Folders 

 

 
 

Then Click Finish 

 

3. The Selfie Wizard will then be available as a Mapped Drive. 

 

 

file://SELFIEWIZARD/Shared-Folders
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Mac Computers 
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Back to Top 

 

Pre-load Image Sets 

Please Note this is a temporary method and will change in a future update. 

Prepare the set of images on a separate computer; images should be correctly 

orientated for display and resized. 

Sizing - for a 2 column display on a 1080p TV the Selfie Wizard will resize images 

down to 500 x 500px. 

Images uploaded at higher resolution will simply create more workload for the 

Selfie Wizard and may result in screen stutter. Keep any images placed in the 

shared folders small. 

 

Connect the Selfie Wizard to your Computer or Network: 

Username:  swiz 

Password:  swiz 

Copy images into SetA – SetD for use in the SlideShow. 

 

Back to Top 

 

Custom Print Overlays 

Please Note this is a temporary method and will change in a future update. 

Three overlays are required to cater for Landscape, Portrait and Square image 

uploads. 

The ‘Overlay-Samples’ shared folder on the Selfie Wizard contains 3 sample PSD 

template files to use as a starting point for your own custom overlays. The layers 

within the files show positioning for the image and framing. 

Overlays must be saved as: 

 PNG file format 

 1800 x 1200 px 

 Correctly orientated 
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 Named EXACTLY as per the example files pre-loaded in the ‘Overlay’ folder 

o overlay-L.png 

o overlay-P.png 

o overlay-S.png 

Over-write the samples to use your own custom templates. 

 

 

Back to Top 

 

Wireless Print Server & Printer Sharing 

Please Note this is a temporary method and will change in a future update. 

The Selfie Wizard can act as a Wired or Wireless Print Server and allowing sharing 

of a connected printer with other computers such as photo booths. 

 

The printer must be correctly installed and working on the Selfie Wizard. 

The Selfie Wizard must be visible on the Computers Network and sharing enabled 

and working. 

Windows Setup 

1. From the Devices and Printers Window > Add a printer 

2. Select > Add a network, wireless or Bluetooth printer 

3. Select > The printer I want isn’t listed 

4. Select > Select a shared printer by name 

Enter:  http://selfiewizard:631/printers/xxxx 

Replace xxxx with the name of your printer on the Selfie Wizard 

Click Next 



Page | 25 
 

 
5. Windows will prompt to install the correct driver for you printer 

6. Follow the rest of the on-screen instructions to complete setup 

7. This networked printer connection will now be available to your Windows 

machine to allow printing via the Selfie Wizard 

Back to Top 

 

Wi-Fi Hotspot 

The Selfie Wizard can act as Wi-Fi Hotspot Access Point to guests at an event. 

Method 1 - Using the Yellow Data Cable, simply plug the Selfie Wizard into a 

Router with internet access. 

Method 2 - Using the Yellow Data Cable, plug the Selfie Wizard directly to a 

computer/laptop that has internet access and Internet Connection Sharing (ICS) 

enabled.  No other configuration is needed. 
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Back to Top 

 

Display Images from a Photo Booth 

Breeze Booth Software and most other photo booth software allow the saving of 

a copy of the booth images to a separate folder. 

Set the Selfie Wizard up as a networked device to your computer using any of the 

methods described in Connect to a computer Network. 

Set your booth software to save a copy of the images to one of the shared folders 

on the Selfie Wizard SetA - SetD. 

The images will then be available to display in a SlideShow and will automatically 

update with new images as they are created. 

 

FTP Uploads 

The Selfie Wizard can accept photo uploads via FTP from Wireless Enabled 

Cameras. 

Connect the camera to the Selfie Wizard Wifi 

Username: swiz 

Password: swiz 

IP Address: 10.10.10.10 

Port: 21 

Home directory should be set to:  / 
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Uploaded images are automatically resized for display and printing 

 

Back to Top 

 

Problems..? 

Stutter on SlideShow 

The scrolling Photo Wall transition is particularly resource intensive as images are 

continuously being resized and loaded into memory to provide the scrolling 

effect. The faster the scroll and the more columns the harder it has to work and 

may result in a scroll stutter. Reducing columns and/or slowing the transition 

speed will reduce any stutter. 

Back to Top 

 

Not able to connect to the Selfie Wizard WiFi 

From Startup/Reboot – The most likely cause will be Wi-Fi interference from 

other equipment in the vicinity. Typically WDMX Uplighters, Radio Microphones, 

Venue Wi-Fi. 

A change of Wi-Fi channels may resolve the problem. 

Mid-event – On rare occasions Wi-Fi may become unresponsive or refuse new 

connections. Reboot the Selfie Wizard by removing power for 1 minute. Wait till 

all lights on the unit have gone out and apply power again. 

 

Back to Top 

 

Guest Phone Connections 

The most frequent problem is simply guests not following the 2 step process 

1. Connect to the Selfie Wizards Wifi Network 

2. In the phone’s web browser enter:  Selfie/ 
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Things to check for 

 Google Search box – This will not work as its NOT a web browser but a 

Search Widget that will try to retrieve internet search results 

 

 Android Phones – Smart Network Switch (Data Roaming) must be switched 

off otherwise the phone will switch over to the mobile data connection 

 

 iPhones – uploads from cloud storage is only possible if the Selfie Wizard is 

connected to an internet connection.  Guests will need to upload images 

that are actually stored on the iPhone. 

 

 Some Huawei phones feature a custom Android install that ignores 

standard DNS protocols. To access the normal upload screen enter the 

Selfie Wizard IP Address into a browser window: 10.10.10.10 

 

Back to Top 


